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Many of us look at A11y from the perspective of web development, but ignoring office 
documents and PDFs would be a huge mistake. When we do apply A11y to PDFs, it's by 
adapting WCAG principles. That's a great place to start. But there are other relevant guidelines to 
follow. In this session, we'll compare the WCAG and PDF/UA guidelines and recognize which 
individual guidelines apply to PDF Accessibility. We'll also look at the Matterhorn Protocol and 
see how it relates to PDF/UA. We'll also cover the necessity and techniques of embedding fonts 
in both MSO documents and PDFs. 
 
This will build upon my earlier presentation, but it will not be necessary to have attended the 
earlier one to understand this next one. 
 
HIGHLIGHTS: 



• How do the WCAG and PDF/UA guidelines relate to each other? 
• Which specific guidelines apply to PDFs? 
• What are their respective limitations and potential pitfalls? 
• What is the Matterhorn Protocol and how does it apply? 
• What are the checkpoints unique to the PDF/UA and which checkpoints might not be 

relevant and in what situations? 
• Why would you lose headings when exporting Word documents to PDF? 
• Why and how do we embed fonts? 
• What happens to the document title when it is exported from a Word document to PDF? 
• How can OCR be deceptive? 
• What are Bookmarks in PDFs and what are the best practices for them? 
• How should AT address the content in headers and footers and what does that mean to 

document authors? 
• When are "article threads" an issue? 
• What is XFA and when is it a problem? 
• What are the Base 14 fonts? 
• What is the PDF Association's recommendation on the best approach to generating 

universally-accessible PDF documents? 
 
THREE TAKE-AWAYS: 
• Making the most accessible PDFs possible 
• Locating the best single checklist for PDF A11y 
• Identifying which guidelines are N/A 
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Life is too short to be spent 
photographing slides. 

A handout containing all the slides and speaker notes can be found at 
http://bit.ly/2y0p5kJ .  (Someone will post this URL to chat.)
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Life is too short to be spent photographing PowerPoint slides.  
 
A handout containing all the slides and speaker notes can be found at http://bit.ly/2y0p5kJ (or 
http://www.boutonjones.com/pub/a11y.html .)  Someone will post this URL to chat. 
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Special Thanks to David Ondich.   
 
David Ondich is a huge reason for why I put this presentation together as well and the manner 
and the content.  David is the ADA Program Manager for the City of Austin and he is a user of 
assistive technology.  Over the past two years David and I have been discussing and sharing 
information and perspective on this this topic.  He’s made me aware of situations that are 
otherwise invisible to me and I’ve explained to him the technological causes of his accessibility 
frustrations. 
 
We’ve co-presented on Accessibility together several times.  This session is largely based on that 
content but it’s been expanded an refocused for a more technical perspective. 
 
David Ondich, M.S., is the City of Austin, Americans with Disabilities Act Program Administrator 
and in 2014 was named Legal Subject Matter Expert on the Americans with Disabilities Act. His 
experience and education include 
• 16 Years as ADA Program Manager or Coordinator for Austin and Fort Worth 
• Master’s Degree in Rehabilitation Counselling Psychology from UT Southwestern Medical 

School of Allied Health and 48 Doctoral hours in Rehabilitation Counseling from The 
University of Texas at Austin 

 



He currently oversees municipal compliance with Titles I and II of the Americans with 
Disabilities Act, which includes: 
• Providing feedback on accessibility to electronic information. 
• Reviewing all employee requests for reasonable accommodations; 

Consulting with department personnel regarding legal obligations under Titles I and II of the 
ADA 

• Arranging for accommodations to allow the public access to all city facilities, programs and 
activities 

• Providing training to city personnel regarding obligations under the ADA as amended. 
 
“Nothing about us without us.”  
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PDF Accessibility (A11y) 101 Review
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Handout: https://www.boutonjones.com/pub/a11y/a11y_accessu_2021_handout.pdf
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In Review (Slide 1 of 5): Do Not Scan to PDF

“A picture may be worth a thousand words --- but not 
if it's a picture of a thousand words that you're trying 
to read with accessible technology.”
- David Ondich
ADA Program Manager for the City of Austin

PITFALL:  When you scan a printed document – e.g. a signed contract, police report, corporate 
policy, or anything requested for discovery – it is no more than an image of the hard copy.  It will 
not be accessible to screen readers in its current form.

Bouton Jones3/25/2021 5

If you must scan to PDF, then perform OCR and then remediate.

 

 

In Review (Slide 1 of 5): Do Not Scan to PDF  
 
PITFALL:  When you scan a printed document – e.g. a signed contract, police report, 
corporate policy, or anything requested for discovery – it is no more than an image of 
the hard copy.  It will not be accessible to screen readers in its current form. 
 
If you can’t “copy and paste” text, it most likely is an image. 
 
As David Ondich (The ADA Program Manager for the City of Austin) has said “A picture 
may be worth a thousand words --- but not if it's a picture of a thousand words that 
you're trying to read with accessible technology.” 
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Question: When is a PDF with text an “untagged” document?In Review (Slide 2 of 5): Save to PDF

Never Print to PDF!

Thursday, March 25, 2021 6

Always Export to PDF or Save as 
PDF instead

Get the slides and notes at http://bit.ly/2y0p5kJ
Bouton Jones3/25/2021 6

Never print to PDF.  Always export to --- or save as --- PDF.  That way the semantic formatting (the tags) will be 
included.

 

 

In Review (Slide 2 of 5): Save to PDF 
 
Never print to PDF.  Always export to --- or save as --- PDF.  That way the semantic formatting 
(the tags) will be included. 
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In Review (Slide 3 of 5)

• Only use PDFs when they are the best option.
• It’s better to remediate and export an accessible source document to 

PDF than to remediate an inaccessible PDF.
• Testing

• Perform both automated and manual testing.
• Check the accessibility of your source documents before exporting 

to PDF.
• Check the accessibility of your PDFs before publishing.
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In Review (Slide 3 of 5) 
 
• Only use PDFs when they are the best option. 
• It’s better to remediate and export an accessible source document to PDF than to remediate 

an inaccessible PDF. 
• Testing 

• Perform both automated and manual testing. 
• Check the accessibility of your source documents before exporting to PDF. 
• Check the accessibility of your PDFs before publishing. 
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In Review (Slide 4 of 5)

• Apply WCAG Guidelines to PDFs
• Use Semantic markup
• Use Alternative text or captions for non-decorative images.
• Specify the document language
• Color guidelines (e.g. contrast, color blindness, etc.,)
• Avoid using tables for layout

• Electronic Forms
• Make sure form fields are in the correct order
• Make sure form fields are properly labeled

• Properly redact documents electronically (do not mask.)
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In Review (Slide 4 of 5) 
 
• Apply WCAG Guidelines to PDFs 

• Use Semantic markup. 
• Use Alternative text or captions for non-decorative images. 
• Specify the document language 
• Color guidelines (e.g. contrast, color blindness, etc.,) 

• Electronic Forms 
• Make sure form fields are in the correct order 
• Make sure form fields are properly labeled 

• Properly redact documents electronically (do not mask.) 
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In Review (Slide 5 of 5):
A Book about PDF Remediation

Fix PDF Files for Accessibility: The Easy and 
Ultimate Guide to Applying Section 508 and 
WCAG 2.0 to PDF Files 
1st Edition
by Ed Thrush 
Paperback : 148 pages
ISBN-10 : 1514608936
ISBN-13 : 978-1514608937
https://www.amazon.com/Fix-PDF-Files-
Accessibility-Ultimate/dp/1514608936/
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In Review (Slide 5 of 5): A Book about PDF Remediation 
  
Fix PDF Files for Accessibility: The Easy and Ultimate Guide to Applying Section 508 and WCAG 
2.0 to PDF Files  
1st Edition 
by Ed Thrush  
Paperback : 148 pages 
ISBN-10 : 1514608936 
ISBN-13 : 978-1514608937 
  
https://www.amazon.com/Fix-PDF-Files-Accessibility-Ultimate/dp/1514608936/  
  
AMAZON.com DESCRPTION:  This book provides the easiest way to get to the required 
accessibility of a PDF file. It is rare for any PDF to come out perfect for accessibility and as a 
result almost all PDF files will need some type of work. In addition to the easy nuts and bolts 
methods to make PDF files work for the disabled, there are also condensed methods for 
preparation of documents commonly converted to PDF. In addition, there are instructions for 
managers and even contract language. You can get a legal history or technical lesson elsewhere, 
this book is for getting to work fixing PDF files for accessibility. 
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PDF A11y 201
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Meetup: https://www.meetup.com/a11yATX/events/276826282/

 

 

PDF A11y 201 
 
This presentation will pick up where the last one left off. 
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WCAG and PDF/UA

WCAG PDF/UA
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Title Slide: WCAG and PDF/UA 
 
IMAGE: Very simple Venn diagram for WCAG and PDF/UA.  Two overlapping circles.  No data 
points. 
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Two Organizations and Their Guidelines

Web Accessibility Initiative (WAI) of the 
World Wide Web Consortium (W3C)

1. Web Content Accessibility 
Guidelines (WCAG) 

2. Authoring Tool Accessibility 
Guidelines (ATAG)

3. User Agent Accessibility 
Guidelines (UAAG)

PDF Association

PDF/Universal Accessibility 
(PDF/UA) or ISO 14289-1

• How to produce accessible PDFs 
• “Define compliant assistive 

technology and PDF reading 
software.”
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Two Organizations and Their Guidelines 
 
A table with two columns, a header row, and a data row. 
 
First column 
 
Header: The Web Accessibility Initiative (WAI) of the World Wide Web Consortium (W3C) 
 
Data: 
• Web Content Accessibility Guidelines (WCAG)  
• Authoring Tool Accessibility Guidelines (ATAG) 
• User Agent Accessibility Guidelines (UAAG) 
 
Second Column 
 
Header: PDF Association 
 
Data: 
PDF/Universal Accessibility (PDF/UA) or ISO 14289-1 
• How to produce accessible PDFs  
• “Define compliant assistive technology and PDF reading software.” 
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Guidelines published by the International 
Organization for Standardization (ISO)W3C

• Web Content Accessibility Guidelines (WCAG) 
2.0

• World Wide Web Consortium (W3C)
• For websites, HTML-based material, and 

additional web technologies (including PDFs)
• Guidelines for A11y web designers, web 

developers, and CMS authors.
• 50 Checkpoints/Guidelines

PDF Association

• PDF/Universal Accessibility (PDF/UA) or ISO 
14289-1

• PDF Association
• For PDF documents
• Guidelines for producing accessible PDFs but 

also “define compliant assistive technology 
and PDF reading software.”

• 31 Checkpoints (many of which overlap with 
the WCAG)
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International Organization for Standardization (ISO) Guidelines 
 
• PDF/UA (Universal Access, or ISO 14289) 
• Web Content Accessibility Guidelines (WCAG) 2.0 
 
The International Standard for accessible PDF *technology* is ISO 32000-1 "PDF/UA 
(PDF/Universal Accessibility)" 
 
On February 18, 2015 the US Access Board announced its Proposed Rule for US federal policy on 
accessibility, commonly known as Section 508. The proposed rule identifies PDF/UA as 
equivalent to WCAG 2.0 for "appropriate content".[4] 
 
You can create PDFs to meet common accessibility standards, such as Web Content Accessibility 
Guidelines (WCAG) 2.0 and PDF/UA (Universal Access, or ISO 14289). 
 
 
 
 
 

  



Slide 14 

 

Diagram from the PDF Association
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IMAGE SOURCE: https://www.pdfa.org/infographics-pdfua-and-wcag-2-0/

 

 

Diagram from the PDF Association 
 
IMAGE: an overly complex Venn Diagram for PDF/UA and WCAG. 
 
IMAGE SOURCE: https://www.pdfa.org/infographics-pdfua-and-wcag-2-0/   
 
I didn’t find this article helpful. 
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Guideline Comparison

Standard Number of Guidelines
WCAG (not PDF applicable) 27
Guidelines in Common 23
PDF/UA Only 8

3/25/2021 Bouton Jones 15

NOTE: This is subjective.  These numbers are rough estimates and subject to 
interpretation.  These guidelines rarely correspond one-to-one. Your findings will 
be close but might vary from mine.

 

 

Guideline Comparison 
 
There is a large overlap in guidelines between WCAG and PDF/UA but each one also have 
guidelines that the other does not 
 
DISPLAY: a two column table for 1) the specific standard and 2) number of guidelines 
 
• 27 WCAG guidelines that are not applicable to PDF 
• 23 guidelines in common with both WCAG and PDF/UA 
• 8 more guidelines for PDF/UA only 
 
NOTE: This is subjective.  These numbers are rough estimates and subject to interpretation.  
These guidelines rarely correspond one-to-one. Your findings will be closeto mine but might 
vary a bit. 
 
CITE:  
• https://www.w3.org/WAI/GL/WCAG20-TECHS/pdf.html  
• https://www.pubcom.com/blog/2017-01-03/wcag-pdf-standards.html  
 
 
 

  

https://www.w3.org/WAI/GL/WCAG20-TECHS/pdf.html
https://www.pubcom.com/blog/2017-01-03/wcag-pdf-standards.html
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“WCAG mapping to PDF/UA” (from Adobe)

URL: https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html#WCAGmappingtoPDFUA
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“WCAG Mapping to PDF/UA” (from Adobe) 
 
IMAGE: Screen Capture of a detail of the mapping on a web page on Adobe.com. 
 
URL: https://helpx.adobe.com/acrobat/using/create-verify-pdf-
accessibility.html#WCAGmappingtoPDFUA   
 
 

  

https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html#WCAGmappingtoPDFUA
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html#WCAGmappingtoPDFUA


Slide 17 

 

WCAG 
for PDF
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Title slide: WCAG for PDF 
 
 

  



Slide 18 

 

Yes, WCAG 2.0 Covers PDFs.

CITE: http://www.w3.org/TR/WCAG20/#technologydef
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Yes, WCAG 2.0 Covers PDFs. 
 
IMAGE: Screen capture of a page on the W3C website. 
 
The W3C includes "PDF" as a web technology in their Web Content Accessibility Guidelines 
(WCAG) 2.0.  Here’s a blockquote from their website: 
 

technology (Web content) 
mechanism for encoding instructions to be rendered, played or executed by user agents  
Note 1: As used in these guidelines "Web Technology" and the word "technology" (when 
used alone) both refer to Web Content Technologies. 
Note 2: Web content technologies may include markup languages, data formats, or 
programming languages that authors may use alone or in combination to create end-
user experiences that range from static Web pages to synchronized media presentations 
to dynamic Web applications.  
Example: Some common examples of Web content technologies include HTML, CSS, 
SVG, PNG, PDF, Flash, and JavaScript.  

 
Source: Web Content Accessibility Guidelines (WCAG) 2.0, Appendix A: Glossary, 
http://www.w3.org/TR/WCAG20/#technologydef   
 

  

http://www.w3.org/TR/WCAG20/#technologydef
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“PDF Techniques for WCAG 2.0” (W3C WAI)
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URL: https://www.w3.org/WAI/GL/WCAG20-TECHS/pdf.html

 

 

“PDF Techniques for WCAG 2.0” (W3C WAI) 
 
IMAGE: Screen capture of the W3C web page “PDF Techniques for WCAG 2.0” 
 
URL: https://www.w3.org/WAI/GL/WCAG20-TECHS/pdf.html  
 
 

  

https://www.w3.org/WAI/GL/WCAG20-TECHS/pdf.html
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PDF Techniques in WCAG 2.0 (from the W3C WAI)
1. Applying text alternatives to images with the Alt entry in 

PDF documents
2. Creating bookmarks in PDF documents
3. Ensuring correct tab and reading order in PDF documents
4. Hiding decorative images with the Artifact tag in PDF 

documents
5. Indicating required form controls in PDF forms
6. Using table elements for table markup in PDF Documents
7. Performing OCR on a scanned PDF document to provide 

actual text
8. Providing definitions for abbreviations via an E entry for a 

structure element
9. Providing headings by marking content with heading tags in 

PDF documents
10. Providing labels for interactive form controls in PDF 

documents
11. Providing links and link text using the Link annotation and 

the /Link structure element in PDF documents
12. Providing name, role, value information for form fields in 

PDF documents

13. Providing replacement text using the /Alt entry for links in 
PDF documents

14. Providing running headers and footers in PDF documents
15. Providing submit buttons with the submit-form action in 

PDF forms
16. Setting the default language using the /Lang entry in the 

document catalog of a PDF document
17. Specifying consistent page numbering for PDF documents
18. Specifying the document title using the Title entry in the 

document information dictionary of a PDF document
19. Specifying the language for a passage or phrase with the 

Lang entry in PDF documents
20. Using Adobe Acrobat Pro's Table Editor to repair mistagged 

tables
21. Using List tags for lists in PDF documents
22. Indicating when user input falls outside the required format 

or values in PDF forms
23. Providing interactive form controls in PDF documents

https://www.w3.org/WAI/GL/WCAG20-TECHS/pdf.html
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PDF Techniques in WCAG 2.0 (from the W3C) 
 
This is a huge web page!  Here’s an outline of the 23 techniques it covers. 
 
 1. Applying text alternatives to images with the Alt entry in PDF documents 
 2. Creating bookmarks in PDF documents 
 3. Ensuring correct tab and reading order in PDF documents 
 4. Hiding decorative images with the Artifact tag in PDF documents 
 5. Indicating required form controls in PDF forms 
 6. Using table elements for table markup in PDF Documents 
 7. Performing OCR on a scanned PDF document to provide actual text 
 8. Providing definitions for abbreviations via an E entry for a structure element 
 9. Providing headings by marking content with heading tags in PDF documents 
10. Providing labels for interactive form controls in PDF documents 
11. Providing links and link text using the Link annotation and the /Link structure element in PDF 
documents 
12. Providing name, role, value information for form fields in PDF documents 
13. Providing replacement text using the /Alt entry for links in PDF documents 
14. Providing running headers and footers in PDF documents 
15. Providing submit buttons with the submit-form action in PDF forms 
16. Setting the default language using the /Lang entry in the document catalog of a PDF 
document 
17. Specifying consistent page numbering for PDF documents 



18. Specifying the document title using the Title entry in the document information dictionary 
of a PDF document 
19. Specifying the language for a passage or phrase with the Lang entry in PDF documents 
20. Using Adobe Acrobat Pro's Table Editor to repair mistagged tables 
21. Using List tags for lists in PDF documents 
22. Indicating when user input falls outside the required format or values in PDF forms 
23. Providing interactive form controls in PDF documents 
 
CITE: https://www.w3.org/WAI/GL/WCAG20-TECHS/pdf.html  
 
 

  

https://www.w3.org/WAI/GL/WCAG20-TECHS/pdf.html
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“Accessibility Support Documentation for 
PDF” (W3C WAI)

CITE: https://www.w3.org/WAI/GL/WCAG20/implementation-report/PDF_accessibility_support_statement
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“Accessibility Support Documentation for PDF” (W3C WAI) 
 
IMAGE:  Screen capture of web page 
 
This web page on the W3C site is specific to WCAG applied to PDFs. 
 
This web page on the W3C web site includes "Support Information for WCAG 2.0 Checkpoints" 
https://www.w3.org/WAI/GL/WCAG20/implementation-
report/PDF_accessibility_support_statement  
 
 

  

https://www.w3.org/WAI/GL/WCAG20/implementation-report/PDF_accessibility_support_statement
https://www.w3.org/WAI/GL/WCAG20/implementation-report/PDF_accessibility_support_statement
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“WCAG 2.0 Requirements Beyond PDF/UA” (AIIM)

CITE: https://www.aiim.org/Global/AIIM_Widgets/Community_Widgets/Achieving_WCAG
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“WCAG 2.0 Requirements Beyond PDF/UA” (on the AIIM web site) 
 
--- Begin Blockquote --- 
 
WCAG 2.0 Requirements Beyond PDF/UA 
 
WCAG 2.0 provides guidelines for general web content and is thus far broader in scope than 
PDF/UA. In some cases, therefore, PDF/UA conformance alone cannot assure conformance with 
WCAG 2.0 and direct reference to the WCAG 2.0 Guidelines is required. 
 
The following list explains terms used in the Achieving WCAG 2.0 with PDF/UA table to help 
identify cases in which a WCAG 2.0 conformance claim cannot use PDF/UA alone to conform to 
WCAG 2.0 but requires validation against WCAG 2.0 directly in addition to applicable PDF/UA 
requirements. 
 
• Time-based media alternatives, test, sensory and CAPTCHAs.  PDF/UA does not address these 

items. Refer to WCAG 2.0. 
• Audio and/or Video content. PDF/UA includes syntactical requirements but does not address 

the actual audio and video content. Refer to WCAG 2.0. 
• Video captions. PDF/UA does not address video captions. Refer to WCAG 2.0. 
• JavaScript design. While identifying some requirements for accessible scripting with PDF 

technology, PDF/UA is not a JavaScript accessibility standard. Refer to WCAG 2.0. 



• JavaScript or Media content. As above, PDF/UA is not a JavaScript or multimedia accessibility 
standard. Refer to WCAG 2.0. 

• Control device specific. PDF/UA is control device-independent. Refer to WCAG 2.0. 
• Design consideration. In general, PDF/UA does not address visual appearance, content or 

design choices and relies on semantic equivalents. Refer to WCAG 2.0. 
• Dynamic XFA-PDF. While prohibited in PDF/UA, dynamic XFA-PDF is not prohibited by WCAG 

2.0. 
 
--- End Blockquote --- 
 
CITE: https://www.aiim.org/Global/AIIM_Widgets/Community_Widgets/Achieving_WCAG  
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PDF/UA 
and the Matterhorn Protocol
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Title Slide: PDF/UA and the Matterhorn Protocol 
 
 

  



Slide 24 

 

PDF/UA in a Nutshell

PDF/UA in a Nutshell
By Olaf Drümmer and Bettina 
Chang 
Published by the PDF Association
August 1, 2013
21 pages
Free
https://www.pdfa.org/resource/pdf
ua-in-a-nutshell/

“Rather than applying to the PDF file 
format alone, these clear specifications 
also define compliant assistive technology 
and PDF reading software.”

3/25/2021 Bouton Jones 24

 

 

PDF/UA in a Nutshell 
 
By Olaf Drümmer and Bettina Chang  
Published by the PDF Association 
August 1, 2013 
21 pages 
Free 
 
ISO standard 14289-1, known as PDF/UA, was first published in the summer of 2012. It is the 
first complete definition of a set of requirements for universally accessible PDF documents. 
Rather than applying to the PDF file format alone, these clear specifications also define 
compliant assistive technology and PDF reading software. 
 
In signing the UN Convention on the Rights of Disabled Persons, many countries have chosen to 
work towards building a more inclusive society. They are now required to turn these inclusive 
principles into a reality on the national level and to remove existing barriers to social inclusion. 
One key area of activity here is in access to information and communications in the form of 
documents a subject which PDF/UA now stands to greatly simplify. 
 
PDF/UA in a Nutshell will show you just what PDF/UA is. This brochure provides a clear 
summary of the key facts, the standard s requirements, the latest developments and the current 
legal situation regarding PDF accessibility, all in one place. In addition, it suggests potential 



applications for the standard and lists the tools that can be used to create and validate PDF/UA-
compliant documents. 
 
CITE: https://www.pdfa.org/resource/pdfua-in-a-nutshell/  
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Tagged PDF Best Practice Guide: Syntax
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Tagged PDF Best Practice Guide: Syntax

"A publication of the PDF/UA Technical 
Working Group, this document is intended 
for developers implementing tagged PDF and 
PDF/UA. Others (including authors with some 
technical knowledge of PDF’s accessibility 
mechanisms) may also benefit from this 
document.

"This guide is also intended to be useful for 
those performing detailed accessibility 
testing on PDF documents claiming 
conformance with PDF/UA, or on PDF 
documents claiming to be accessible 
according to some other specification.“

URL: https://www.pdfa.org/resource/tagged-
pdf-best-practice-guide-syntax/

 

 

Tagged PDF Best Practice Guide: Syntax 
 

A publication of the PDF/UA Technical Working Group, this document is intended for 
developers implementing tagged PDF and PDF/UA. Others (including authors with 
some technical knowledge of PDF’s accessibility mechanisms) may also benefit from 
this document. 
 
This guide is also intended to be useful for those performing detailed accessibility 
testing on PDF documents claiming conformance with PDF/UA, or on PDF documents 
claiming to be accessible according to some other specification. 
 
Keep in mind that as of today most PDF documents do not follow these 
recommendations. 

 
URL: https://www.pdfa.org/resource/tagged-pdf-best-practice-guide-syntax/  
 
 

  

https://www.pdfa.org/resource/tagged-pdf-best-practice-guide-syntax/
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PDF/UA is based on WCAG

CITE: https://www.pdfa.org/resource/pdfua-in-a-nutshell/
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The PDF/UA is based on WCAG 
 
“The requirements for PDF/UA are based on the principles of Version 2.0 of the W3C 
consortium’s Web Content Accessibility Guidelines (WCAG), also published in identical form as 
an ISO standard in October 2012 (ISO/IEC 40500). WCAG 2.0 guides the creation of accessible 
web content, focusing on the kinds of content and applications usually provided on websites.” 
 
“Some WCAG 2.0 tips of a purely informative nature suggest how barriers to access can also be 
avoided in PDF documents, but a systematic explanation or guide is not provided. PDF/UA, on 
the other hand, exclusively and fully addresses the PDF format, bringing the ideas behind WCAG 
2.0 into the world of PDF and setting PDF-specific rules.” 
 
CITE:  https://www.pdfa.org/resource/pdfua-in-a-nutshell/   
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PDF/UA Technical Requirements

• All real (meaningful) content shall be tagged. Artifacts (non-meaningful content) shall not 
be tagged.

• The “tag tree” created by the individual tags (representing the document’s content)  
should be sorted to reflect the document’s logical reading order.

• All structure types in use shall be standard or mapped to standard
• A manual check of the document is required to ensure that there is no information 

conveyed using visual means alone (e.g. contrast, color etc.), and that there is no 
flickering, blinking or flashing content.

• A document title must be given in the metadata. In the Document Properties, the Initial 
View settings must be set up so that the title (rather than the file name) appears in the 
window title (under Window Options).

• Any non-text elements (images, charts, graphs, infographics, logos, etc.) must have 
corresponding alternative text.

CITE: https://accessible-docs.com/overview-pdf-ua-standard/
3/25/2021 Bouton Jones 27

 

 

PDF/UA Technical Requirements 
 
“WCAG 2.0 compliance 
 
“The W3C’s Web Content Accessibility Guidelines 2.0 (WCAG 2.0) was written with Web content 
in mind. The application of WCAG 2.0 to other electronic content requires interpretation to 
determine how to apply the WCAG 2.0 Principles, Guidelines and Success Criteria. There is not 
always a 1:1 mapping. 
 
“In the case of PDF documents, the international standard (ISO14289-1:2014)  defines 
requirements specifically for accessible PDF files. The requirements for the PDF/UA standard are 
complementary to the WCAG 2.0 success criteria, and are therefore compliant with its 
requirements. This means that a PDF file which is compliant to the PDF/UA standard will also be 
compliant to ADA, Section 508 and AODA requirements. 
 
“PDF/UA technical requirements 
 
“The following are just a few of the technical requirements as set out by the PDF/UA standard:” 
 
• All real (meaningful) content shall be tagged. Artifacts (non-meaningful content) shall not be 

tagged. 
• The “tag tree” created by the individual tags (representing the document’s content)  should 

be sorted to reflect the document’s logical reading order. 



• All structure types in use shall be standard or mapped to standard 
• A manual check of the document is required to ensure that there is no information conveyed 

using visual means alone (e.g. contrast, color etc.), and that there is no flickering, blinking or 
flashing content. 

• A document title must be given in the metadata. In the Document Properties, the Initial View 
settings must be set up so that the title (rather than the file name) appears in the window 
title (under Window Options). 

• Any non-text elements (images, charts, graphs, infographics, logos, etc.) must have 
corresponding alternative text. 

 
CITE: https://accessible-docs.com/overview-pdf-ua-standard/  
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“PDF/UA Requirements Unaddressed in WCAG 2.0” (AIIM)

CITE: https://www.aiim.org/Global/AIIM_Widgets/Community_Widgets/Achieving_WCAG
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“PDF/UA Requirements Unaddressed in WCAG 2.0” (AIIM) 
 
--- Begin Blockquote --- 
 
In a few cases PDF/UA includes key objectives or requirements with no precise or near-
equivalent in WCAG 2.0. These cases include: 
 
• Interoperability (consistency and reliability). PDF is distinguished from other formats by the 

fact that reliable, consistent rendering (content delivery) irrespective of consuming software 
(viewers, printers, assistive technology, etc.) is its key value proposition. Both operationally 
and economically, a high degree of interoperability is as vital to equal access to PDF content 
as reliable rendering is critical to PDF's value on-screen and in-print. WCAG 2.0 does not 
normatively address interoperability. 

 
PDF/UA is a classical interoperability-oriented technology standard. A fundamental 
design objective was the creation of normative requirements for ensuring accessibility-
related features are maximally interoperable. 

 
• Fonts. Font substitutions can result in compromised legibility for any user, and especially for 

cognitively impaired and dyslexic users. WCAG 2.0 addresses fonts to some extent via SC 
1.4.5 but has no provisions regarding fidelity to source content, legibility problems 
occasioned by mismanagement of fonts or the specific use of fonts to suit accessibility 
purposes. 



 
PDF/UA 7.21 requires embedded fonts to ensure the accurate conveyance of the 
author's intent with the highest degree of legibility. 

 
• Headings as Navigation. In the vast majority of PDF files (as well as in other file formats), 

headings (H1, H2, H3, etc.) are the only feature providing equivalent intra-document 
navigation for AT users. WCAG 2.0 does not address the navigational role of headings nor 
does WCAG 2.0 require that headings be logically structured. 

 
PDF/UA 7.4 requires that headings are logically structured to enable navigation.  

 
• Article Threads. No longer frequently used, the PDF article threads feature is a quick-and-

dirty way of providing a window-width view that automatically scrolls forward with each 
click. Tagged PDF readers may deliver this same functionality today using the tags tree, if 
desired. WCAG 2.0 does not address this feature. 

 
PDF/UA 7.12 requires that if present, article threads shall follow the logical structure 
(tags) of the document.  

 
--- End Blockquote --- 
 
CITE: https://www.aiim.org/Global/AIIM_Widgets/Community_Widgets/Achieving_WCAG  
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PDF/UA Beyond the WCAG (Slide 1 of 2)

• Document Title
• Quotes and Blockquotes
• Embed Fonts
• Article Threads
• Captions
• Don’t use background images or watermarks
• Don’t use flickering, blinking or flashing content
• Don’t use Dynamic XFA forms
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PDF/UA Beyond the WCAG (Slide 1 of 2) 
 
• Document Title 
• Quotes and Blockquotes 
• Embedded Fonts 
• Article Threads 
• Captions 
• Don’t use background images or watermarks 
• Don’t use Dynamic XFA forms. (If you don’t know what they are don’t worry about it.) 
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PDF/UA Beyond the WCAG (slide 2 of 2)

• Use standard structure types --- or map to standard structure types 
with a role map in the structure tree root.

• Tag any information --- that was conveyed by visual means alone 
(contrast, color, format, or layout) --- to reflect the intended meaning. 

• Headings
• Only use Heading levels 1 through 6 
• You can have more than one Heading level 1
• Do not separate a Heading into two parts
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PDF/UA Beyond the WCAG (Slide 2 of 2) 
 
• Use standard structure types or map to standard structure types, with a role map in the 

structure tree root. 
• Any Information conveyed by contrast, color, format or layout must also be tagged to reflect 

the intended meaning. 
• Headings 

• You can have more than 1 Heading level 1 
• Only use heading levels H1 – H6.  Unlike HTML, the PDF format doesn’t include 

additional heading levels (e.g. H7.)  This is not an issue in Word 
• Do not separate a Heading into two parts 
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Chat Poll: What is the Matterhorn?
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Chat Poll: What is the Matterhorn? 
 
IMAGE:  The Mattterhorn 
 
It is a mountain of the Alps with a summit 14,692 feet (or 4,478 metres) high, making it one of 
the highest summits in Europe. 
 
FROM Wikipedia:  “The first ascent of the Matterhorn was in 1865 from Zermatt by a party led 
by Edward Whymper; it ended when four of its seven members fell to their deaths on the 
descent. This disaster, later portrayed in several films, marked the end of the golden age of 
alpinism. …. It is estimated that over 500 alpinists have died on the Matterhorn, making it one 
of the deadliest peaks in the world.” 
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What is the Matterhorn Protocol?

Is it yet another set of A11y guidelines to learn?
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What is the Matterhorn Protocol?  
 
Is it yet another set of A11y guidelines to learn? 
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Matterhorn Protocol definedMatterhorn Protocol:
A list of all the possible ways to fail PDF/UA produced by the PDF Association's 
PDF/UA Competence Center.  It consists of 31 Checkpoints comprised of 136 
Failure Conditions. 

3/25/2021 Bouton Jones 33

It’s based on the PDF/UA.

 

 

Matterhorn Protocol defined 
 
Matterhorn Protocol:  a list of all the possible ways to fail PDF/UA produced by the PDF 
Association's PDF/UA Competence Center.  It consists of 31 Checkpoints comprised of 136 
Failure Conditions.   
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Download the Matterhorn Protocol PDF

Document Version 1.02 | April 30, 2014 | 13 pages

URL: https://www.pdfa.org/wp-content/uploads/2014/06/MatterhornProtocol_1-02.pdf
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Download the Matterhorn Protocol PDF 
 
Document Version 1.02 | April 30, 2014 | 13 pages 
 
URL:  https://www.pdfa.org/wp-content/uploads/2014/06/MatterhornProtocol_1-02.pdf  
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Matterhorn Protocol: PDF/UA-1 Checkpoints
1. Real content tagged 
2. Role Mapping 
3. Flickering 
4. Color and Contrast 
5. Sound 
6. Metadata 
7. Dictionary 
8. OCR Validation 
9. Appropriate Tags 
10. Character Mappings 
11. Declared Natural 

Language  
12. Stretchable Characters 
13. Graphics 
14. Headings 
15. Tables 
16. Lists 
17. Mathematical 

Expressions 
18. Page Headers and 

Footers 
19. Notes and References 
20. Optional Content 

21. Embedded Files 
22. Article Threads 
23. Digital Signatures 
24. Non-Interactive Forms 
25. XFA 
26. Security 
27. Navigation 
28. Annotations 
29. Actions
30. XObjects
31. Fonts
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Matterhorn Protocol: PDF/UA-1 Checkpoints 
 

1. Real content tagged  
2. Role Mapping  
3. Flickering  
4. Color and Contrast  
5. Sound  
6. Metadata  
7. Dictionary  
8. OCR Validation  
9. Appropriate Tags  
10. Character Mappings  
11. Declared Natural Language   
12. Stretchable Characters  
13. Graphics  
14. Headings  
15. Tables  
16. Lists  

17. Mathematical Expressions  
18. Page Headers and Footers  
19. Notes and References  
20. Optional Content  
21. Embedded Files  
22. Article Threads  
23. Digital Signatures  
24. Non-Interactive Forms  
25. XFA  
26. Security  
27. Navigation  
28. Annotations  
29. Actions 
30. XObjects  
31. Fonts 
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Checkpoint 01: Real content tagged

Use standard structure types --- or map to standard structure types with a 
role map in the structure tree root.

Failure Condition 1-006 : The structure type and attributes of a structure 
element are not semantically appropriate for the structure element.  

48 PDF Structure Types: Document, Part, Art, Sect, Div, BlockQuote, Caption, 
TOC, TOCI, Index, NonStruct, Private, P, H, H1, H2, H3, H4, H5, H6, L, LI, Lbl, 
LBody, Table, TR, TH, TD, THead, TBody, TFoot, Span, Quote, Note, Reference, 
BibEntry, Code, Link, Annot, Ruby, Warichu, RB, RT, RP, WT, WP, Figure, 
Formula, and Form.
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Checkpoint 01: Real content tagged 
 
Failure Condition 1-006 : The structure type and attributes of a structure element are not 
semantically appropriate for the structure element.   
 
48 PDF Structure Types: Document, Part, Art, Sect, Div, BlockQuote, Caption, TOC, TOCI, Index, 
NonStruct, Private, P, H, H1, H2, H3, H4, H5, H6, L, LI, Lbl, LBody, Table, TR, TH, TD, THead, 
TBody, TFoot, Span, Quote, Note, Reference, BibEntry, Code, Link, Annot, Ruby, Warichu, RB, RT, 
RP, WT, WP, Figure, Formula, and Form. 
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Navigation to the Tag Panel In Acrobat
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Navigation to the Tag Panel In Acrobat 
 
IMAGE: Screen capture showing the following navigation ruite. 
 
• Select the View drop down menu 
• Select the Show/Hide option 
• Select the Navigation Panes option 
• Select the Tags option 
 
The Tags pane will appear on the right-hard side of the Acrobat window. 
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Structure Types for Lists

• L - the List tag, which contains one or more LI tags.
• LI - the List Item tag. List item tags can contain Lbl and LBody tags.
• Lbl - the list item label. Contains distinguishing information such as a 

item number or bullet character.
• LBody - the list item body. Contains list item content, or in the case of 

a nested list, it may contain additional List tag trees.
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Structure Types for Lists 

• L - the List tag, which contains one or more LI tags. 
• LI - the List Item tag. List item tags can contain Lbl and LBody tags. 
• Lbl - the list item label. Contains distinguishing information such as an item number or bullet 

character. 
• LBody - the list item body. Contains list item content, or in the case of a nested list, it may 

contain additional List tag trees.  
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Structure Types for References 

Caption, TOC, TOCI, Index, Note, Reference, BibEntry, Annot, and Figure
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Structure Types for References 
 
• Caption 
• TOC 
• TOCI 
• Index 
• Note 

• Reference 
• BibEntry 
• Annot 
• Figure 

 
IMAGE: Screen capture of Microsoft Word ribbon with the References tab selected.  It shows 
the Word options that are equivalent to many of the PDF Structure Type (e.g. Table of Contents, 
Insert Footnote, Insert Citation, Bibiliography, Insert Caption, Insert Index, etc.,) 
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Adding Captions in Word
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Adding Captions in Word 
 
IMAGE: Screen capture of a detail of the References tab in Word. A captions window below 
 
 

  



Slide 41 

 

Structure Types for Tables

3/25/2021 Bouton Jones 41

HTML Tags PDF Structure Types
<table> table
<tr> tr
<th> th
<td> td
<thead> thead
<tbody> tbody
<tfoot> tfoot

THEAD, TBODY, and TFOOT help with pagination.

Adobe InDesign provides TFOOT support.

 

 

Structure Types for Tables 
 
IMAGE: Screen capture of a few table tags in Acrobat’s Tag pane. 
 
Two Column Table with a column header for “HTML Tags” and “PDF Structure Types”.   There are 
7 rows and the contents for both cells in each row are identical.  The repeated contents of the 
rows are:  Table, TR, TH, TD, THead, TBody, Tfoot. 
 
So there is a one-to-one correspondence for table tags in HTML and PDF Structure Types for 
tables. 
 
THEAD, TBODY, and TFOOT help with pagination. 
 
Adobe InDesign provides TFOOT support. 
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Properly Tagging Tables in MS Office

Microsoft 
Word

Microsoft 
PowerPoint

Microsoft 
Excel

Specify column header information in tables (through Semantic Markup.)
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Specify column header information in tables (through Semantic Markup.) 
  
Three SCREEN Captures: Select the table styles that include header rows: 
• In Word 
• In PowerPoint 
• In Excel 
 
 

  



Slide 43 

 

Include Header Rows in Tables When 
Inserting Tables in Word
1. In Word, select the INSERT tab and then the Table icon.

2. Check the Header Row option under the DESIGN (TABLE TOOLS) tab.
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Include Header Rows in Tables When Inserting Tables in Word 
  
• In Word, select the INSERT tab and then the Table icon. 

• Check the Header Row option under the DESIGN (TABLE TOOLS) tab. 
  
IMAGES:  screen captures to illustrate both steps 
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Structure Types for Japanese Typography

• RB
• RP
• RT
• Ruby
• Warichu
• WP
• WT
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Structure Types for Japanese Typography 

 
• RB 
• RP 
• RT 
• Ruby 

• Warichu 
• WP 
• WT 

 
Warichu (literally “split annotation”):  the Japanese word for the traditional East Asian 

typographic device of typesetting in small double lines editorial comments, notes, 
parenthetical comments, and other annotations that may or may not belong to the text 
proper. 
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NonStruct
From the PDF Association’s Tagged PDF Best Practice Guide:

Has no substantive role or meaning; interpretation is out of scope for consumers of tagged PDF. 
NonStruct’s value is primarily as a utility for role mapping custom structure element types for which no 
corresponding standard structure element type is suitable.

A document containing custom structure elements for which there is no corresponding standard structure 
type, but where the content and child elements are intended to be real content. In such a case 
appropriate semantics require a writer to role map the custom element type to NonStruct.

NonStruct has no semantic significance, but its content and contained structure elements may well have 
significance. A consuming processor would be expected to pass these children to AT and other processors.

CITE: https://www.pdfa.org/wp-content/uploads/2019/06/TaggedPDFBestPracticeGuideSyntax.pdf
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NonStruct 
 
From the PDF Association’s Tagged PDF Best Practice Guide: 
 

Has no substantive role or meaning; interpretation is out of scope for consumers of 
tagged PDF. NonStruct’s value is primarily as a utility for role mapping custom structure 
element types for which no corresponding standard structure element type is suitable. 
 
A document containing custom structure elements for which there is no corresponding 
standard structure type, but where the content and child elements are intended to be 
real content. In such a case appropriate semantics require a writer to role map the 
custom element type to NonStruct. 
 
NonStruct has no semantic significance, but its content and contained structure 
elements may well have significance. A consuming processor would be expected to pass 
these children to AT and other processors. 

 
CITE:  https://www.pdfa.org/wp-
content/uploads/2019/06/TaggedPDFBestPracticeGuideSyntax.pdf  
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Private
From the PDF Association’s Tagged PDF Best Practice Guide:

Akin to <NonStruct>, this element differs from <NonStruct> insofar as not only the structure element 
itself, but the children of the structure element, including structure elements and content, are also 
ignored.

CITE: https://www.pdfa.org/wp-content/uploads/2019/06/TaggedPDFBestPracticeGuideSyntax.pdf
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Private 
 
From the PDF Association’s Tagged PDF Best Practice Guide: 
 

Akin to <NonStruct>, this element differs from <NonStruct> insofar as not only the 
structure element itself, but the children of the structure element, including structure 
elements and content, are also ignored. 

 
CITE:  https://www.pdfa.org/wp-
content/uploads/2019/06/TaggedPDFBestPracticeGuideSyntax.pdf  
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Remaining Structure Types

• BlockQuote 
• Code
• Div 
• H (heading, strongly structured)*
• H1 
• H2 
• H3 

• H4 
• H5 
• H6 
• P 
• Quote 
• Span 
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*Due to a lack of suitable tools, the H structure element is impractical, and its use is not recommended.

 

 

Remaining Structure Types 
 

• BlockQuote  
• Code 
• Div  
• H (heading, strongly structured)* 
• H1  
• H2  
• H3  

• H4  
• H5  
• H6  
• P  
• Quote  
• Span  

 
*Due to a lack of suitable tools, the H structure element is impractical, and its use is not recommended. 
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For more about Structure Types:

See the PDF Association’s Tagged PDF Best 
Practice Guide at https://www.pdfa.org/wp-
content/uploads/2019/06/TaggedPDFBestPract
iceGuideSyntax.pdf
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For more about Structure Types: 
 
See the PDF Association’s Tagged PDF Best Practice Guide at https://www.pdfa.org/wp-
content/uploads/2019/06/TaggedPDFBestPracticeGuideSyntax.pdf  
 
IMAGE: First Page of the PDF Association’s Tagged PDF Best Practice Guide . 
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Checkpoint 06: Metadata

3/25/2021 Bouton Jones 49

Index Failure Condition Section
06-001 Document does not contain XMP metadata stream UA1:7.1-8
06-002 The metadata stream in the Catalog dictionary does not include 

the PDF/UA identifier.
UA1:5

06-003 Metadata stream does not contain dc:title* UA1:7.1-8
06-004 dc:title* does not clearly identify the document UA1:7.1-8

*Dublin Core (DC): a set of fifteen "core" elements (properties) for describing resources. This fifteen-element 
Dublin Core has been formally standardized as ISO 15836, ANSI/NISO Z39.85,[2] and IETF RFC 5013. The core 
properties are part of a larger set of DCMI Metadata Terms. "Dublin Core" is also used as an adjective for 
Dublin Core metadata, a style of metadata that draws on multiple RDF vocabularies, packaged and constrained 
in Dublin Core application profiles.  (CITE: https://en.wikipedia.org/wiki/Dublin_Core )

 

 

Checkpoint 06: Metadata 
 
Index Failure Condition Section 
06-001 Document does not contain XMP metadata stream UA1:7.1-8 
06-002 The metadata stream in the Catalog dictionary does not include the PDF/UA identifier.
 UA1:5 
06-003 Metadata stream does not contain dc:title UA1:7.1-8 
06-004 dc:title does not clearly identify the document UA1:7.1-8 
 
*Dublin Core (DC): a set of fifteen "core" elements (properties) for describing resources. This 

fifteen-element Dublin Core has been formally standardized as ISO 15836, ANSI/NISO 
Z39.85,[2] and IETF RFC 5013. The core properties are part of a larger set of DCMI 
Metadata Terms. "Dublin Core" is also used as an adjective for Dublin Core metadata, a 
style of metadata that draws on multiple RDF vocabularies, packaged and constrained in 
Dublin Core application profiles.  (CITE: https://en.wikipedia.org/wiki/Dublin_Core ) 
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Checkpoint 06: 001 XMP

Failure Condition 06-001: Document does not 
contain XMP metadata stream.

3/25/2021 Bouton Jones 50

“The Extensible Metadata Platform (XMP) provides Adobe applications 
with a common XML framework that standardizes the creation, processing, 
and interchange of document metadata across publishing workflows. You 
can save and import the document metadata XML source code in XMP 
format, making it easy to share metadata among different documents. You 
can also save document metadata to a metadata template that you can 
reuse in Acrobat.”

CITE: https://helpx.adobe.com/acrobat/using/pdf-properties-metadata.html

 

 

Checkpoint 06: Failure Condition 06-001 
 
Failure Condition 06-001: Document does not contain XMP metadata stream 
 
“The Extensible Metadata Platform (XMP) provides Adobe applications with a common XML 
framework that standardizes the creation, processing, and interchange of document metadata 
across publishing workflows. You can save and import the document metadata XML source code 
in XMP format, making it easy to share metadata among different documents. You can also save 
document metadata to a metadata template that you can reuse in Acrobat.” 
 
CITE: https://helpx.adobe.com/acrobat/using/pdf-properties-metadata.html  
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Fixes for Missing XMP Data

Instructions to Add Metadata with an XMP File:

• Taggedpdf.com: https://taggedpdf.com/508-pdf-help-
center/pdfua-identifier-missing/

• Accessible-pdf.info: https://accessible-
pdf.info/tutorials/general/pdf-ua-identifier-is-missing
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Fixes for Missing XMP Data 
 
Instructions to Add Metadata with an XMP File: 
 
• Taggedpdf.com: https://taggedpdf.com/508-pdf-help-center/pdfua-identifier-missing/   
 
• Accessible-pdf.info: https://accessible-pdf.info/tutorials/general/pdf-ua-identifier-is-missing  
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Checkpoint 06: 002 PDF/UA Identifier

Failure Condition 06-002: The metadata stream in the Catalog 
dictionary does not include the PDF/UA identifier. 

This is an issue for PDFs created in:
• Microsoft Word 2013 for Windows
• Any version of Adobe InDesign (formerly Adobe PageMaker)

Test with:
• Adobe Acrobat 
• PAC 3 (free testing tool from Access For All)
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Checkpoint 06: 002 PDF/UA Identifier  
 
Failure Condition 06-002: The metadata stream in the Catalog dictionary does not include the 
PDF/UA identifier.  
 
This is an issue with PDFs created in: 
• Microsoft Word 2013 for Windows 
• Any version of Adobe InDesign (formerly Adobe PageMaker) 
 
Test with: 
• Adobe Acrobat  
• PAC 3 (free testing tool from Access for all) 
 
 
 
 
 

  



Slide 53 

 

An example of a complete PDF/UA flag
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CITE: https://www.pdfa.org/wp-content/uploads/2019/06/TaggedPDFBestPracticeGuideSyntax.pdf

 

 

An example of a complete PDF/UA flag 
 
IMAGE: XML code for a complete PDF/UA flag  
 
---- BEGIN CODE --- 
 
<?xpacket begin="" id="W5M0MpCehiHzreSzNTczkc9d"?> 
<x:xmpmeta xmlns:x="adobe:ns:meta/" x:xmptk="Adobe XMP Core 5.6-c015 
91.163280, 2018/06/22-11:31:03 "> 
 <rdf:RDF xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"> 
 <rdf:Description rdf:about="" 
 xmlns:dc="http://purl.org/dc/elements/1.1/" 
 xmlns:pdfuaid="http://www.aiim.org/pdfua/ns/id/"> 
 <dc:title> 
 <rdf:Alt> 
 <rdf:li xml:lang="x-default">PDF/UA Document</rdf:li> 
 <rdf:li xml:lang="en">PDF/UA Document</rdf:li> 
 </rdf:Alt> 
 </dc:title> 
 <pdfuaid:part>1</pdfuaid:part> 
 </rdf:Description> 
 </rdf:RDF> 
</x:xmpmeta> 
<?xpacket end="w"?>  
 
---- END CODE --- 



 
IMAGE and CODE SOURCE:  https://www.pdfa.org/wp-
content/uploads/2019/06/TaggedPDFBestPracticeGuideSyntax.pdf  
 
 

  

https://www.pdfa.org/wp-content/uploads/2019/06/TaggedPDFBestPracticeGuideSyntax.pdf
https://www.pdfa.org/wp-content/uploads/2019/06/TaggedPDFBestPracticeGuideSyntax.pdf


Slide 54 

 

Why must we include the PDF/UA Identifier?

• “This enables reader applications and assistive technologies to fully 
process PDF/UA conforming files to maximize accessibility.” (CITE: 
https://accessiblewebsiteservices.com/accessible-pdfs-how-to-add-a-
pdf-ua-identifier/ )

• “In order for a PDF document to be technically accessible, the PDF/UA
identifier (metadata) must be set.” (CITE: https://accessible-
pdf.info/tutorials/general/pdf-ua-identifier-is-missing )

So, why is that?
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Why must we include the PDF/UA Identifier? 
 
“This enables reader applications and assistive technologies to fully process PDF/UA conforming 
files to maximize accessibility.” (CITE: https://accessiblewebsiteservices.com/accessible-pdfs-
how-to-add-a-pdf-ua-identifier/ ) 
 
“In order for a PDF document to be technically accessible, the PDF/UA identifier (metadata) 
must be set.” (CITE: https://accessible-pdf.info/tutorials/general/pdf-ua-identifier-is-missing ) 
 
So, why is that? 
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https://accessible-pdf.info/tutorials/general/pdf-ua-identifier-is-missing
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The PDF Association on the PDF/UA Identifier

From an email from info@pdfa.org:

The PDF/UA flag is a quality indicator. It prompts AT to 
expect high-quality tagging and other structures required 
for accessibility, as well as alt. text, validated 
disambiguation of real content and artifacts, validated 
reading-order and so on.

But how does including the PDF/UA identifier improve the 
experience of a PWD?
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The PDF Association on the PDF/UA Identifier 
 
From an email from info@pdfa.org: 
 

The PDF/UA flag is a quality indicator. It prompts AT to expect high-quality tagging and 
other structures required for accessibility, as well as alt. text, validated disambiguation 
of real content and artifacts, validated reading-order and so on. 

 
But, how does including the PDF/UA identifier improve the experience of a PWD? 
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Solutions for PDF/UA identifier missing 
(1 of 3)

1. Adobe Acrobat DC

1. Open the PDF document in Adobe Acrobat DC.
2. Select More Tools > Print Production > Preflight
3. In the Preflight dialog, be sure PDF Standards is selected from the dropdown.
4. Activate the wrench icon above the list of Preflight checks. This should open the Document 

info and Metadata settings.
5. Select the Set PDF/UA-1 entry option, then click the Fix button.
6. In the next dialog box, you will need to re-save your file with a different name.

CITE: https://accessiblewebsiteservices.com/accessible-pdfs-how-to-add-a-pdf-ua-
identifier/
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Solutions for PDF/UA identifier missing (1 of 3) 
 
• Adobe Acrobat DC 
 

• Open the PDF document in Adobe Acrobat DC. 
• Select More Tools > Print Production > Preflight 
• In the Preflight dialog, be sure PDF Standards is selected from the dropdown. 
• Activate the wrench icon above the list of Preflight checks. This should open the 

Document info and Metadata settings. 
• Select the Set PDF/UA-1 entry option, then click the Fix button. 
• In the next dialog box, you will need to re-save your file with a different name. 

 
CITE: https://accessiblewebsiteservices.com/accessible-pdfs-how-to-add-a-pdf-ua-identifier/   
 
 

  

https://accessiblewebsiteservices.com/accessible-pdfs-how-to-add-a-pdf-ua-identifier/
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Solutions for PDF/UA identifier missing 
(2 & 3)

2. Add Metadata with an XMP File

• Instructions at taggedpdf.com: https://taggedpdf.com/508-pdf-help-center/pdfua-identifier-
missing/

• Instructions at accessible-pdf.info: https://accessible-pdf.info/tutorials/general/pdf-ua-
identifier-is-missing

3. Automatic approach in InDesign (MadeToTag)

Instructions at accessible-pdf.info: https://accessible-pdf.info/tutorials/general/pdf-ua-
identifier-is-missing
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Solutions for PDF/UA identifier missing (2 & 3) 
 
2. Add Metadata with an XMP File 
 

• Instructions at taggedpdf.com: https://taggedpdf.com/508-pdf-help-center/pdfua-
identifier-missing/  

• Instructions at accessible-pdf.info: https://accessible-pdf.info/tutorials/general/pdf-
ua-identifier-is-missing  

 
3. Automatic approach in InDesign (MadeToTag) 

 
Instructions at accessible-pdf.info: https://accessible-pdf.info/tutorials/general/pdf-ua-
identifier-is-missing   

 
 

  

https://taggedpdf.com/508-pdf-help-center/pdfua-identifier-missing/
https://taggedpdf.com/508-pdf-help-center/pdfua-identifier-missing/
https://accessible-pdf.info/tutorials/general/pdf-ua-identifier-is-missing
https://accessible-pdf.info/tutorials/general/pdf-ua-identifier-is-missing
https://accessible-pdf.info/tutorials/general/pdf-ua-identifier-is-missing
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Slide 58 

 

It’s worth repeating …

A missing PDF/UA Identifier is an issue for PDFs created in:
• Microsoft Word 2013 for Windows
• Any version of Adobe InDesign (formerly Adobe PageMaker)

So ...
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It’s worth repeating … 
 
This is an issue with PDFs created in: 
• Microsoft Word 2013 for Windows 
• Any version of Adobe InDesign (formerly Adobe PageMaker) 
 
So, if you don’t use these programs or don’t maintain legacy documents created with these 
programs, this is probably not an issue for you. 
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Checkpoint 06: 003 & 004 (Dublin Core) Title
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Index Failure Condition Section
06-001 Document does not contain XMP metadata stream UA1:7.1-8
06-002 The metadata stream in the Catalog dictionary does not include the PDF/UA identifier. UA1:5
06-003 Metadata stream does not contain dc:title UA1:7.1-8
06-004 dc:title does not clearly identify the document UA1:7.1-8

 

 

Checkpoint 06: 003 & 004 (Dublin Core) Title 
 
06-003: Metadata stream does not contain dc:title 
06-004: dc:title does not clearly identify the document 
 
IMAGE: Screen capture of the Word ribbon showing the Styles tags with the Title tag selected. 
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In HTML, the Title Tag is in the HEAD Section
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In HTML, the Title Tag is in the HEAD Section 
  
IMAGE: HTML Markup 
  
---- Begin Markup ---- 
  
<html> 
<head> 
     <title>Heading Levels in HTML</title> 
     <link rel="stylesheet" type="text/css" href="styles.css" /> 
</head> 
<body lang="EN-US"> 
  
<p class=MsoTitle>MS Word Title</p> 
<p class=MsoSubtitle>MS Subtitle</p> 
<h1>MS Word Heading Level One</h1> 
<h2>MS Word Heading Level Two</h2> 
<h3>MS Word Heading Level Three</h3> 
<h4>MS Word Heading Level Four</h4> 
<h5>MS Word Heading Level Five</h5> 
<h6>MS Word Heading Level Six</h6> 
<p class=MsoHeading7>MS Word Heading Level Seven</p> 
<p class=MsoHeading8>MS Word Heading Level Eight</p> 
<p class=MsoHeading9>MS Word Heading Level Nine</p> 
  
</body> 



</html> 
  
---- End Markup ---- 
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In Word, users add the Title Tag into the body
of the document.
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In Word, users add the Title Tag into the body of the document. 
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Question: How Does Word’s Title Tag Export 
to PDF?

3/25/2021 Bouton Jones 62

As the PDF’s Title Property (META data?)   

Or as the top most heading level?

 

 

Q: How Does Word’s Title Tag Export to PDF? 
 
Does it export as the PDF’s Title Property (not to be confused with the filename?) 
 
Does it export as the top most heading level? 
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Answer:  In Two Different Ways
1. Title Property (META data) 2. Paragraph Tag (not Heading Level tag)
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How Does the Title Tag Export to PDF? 
 
Does it export as the PDF’s Title Property (not to be confused with the filename?) 
 
Does it export as the top most heading level? 
 
Answer:  It exports to PDF as the title property.   And it exports as a paragraph tag that retains 
the visual formatting (e.g font face, font size, color) from the Word document. 
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An Example Title
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An Example Title 
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You can change the (Title) paragraph into H1.
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You can change the (Title) paragraph in H1. 
 
This will not change the title meta data.   Or the appearance (formatting) of the text in th PDF. 
 
IMAGES:  Two screen captures showing the Tag panel in Adobe Acrobat.  In the first, the text 
“This is the title” is nested inside the P tag.  In the second, the same text is nested inside the H1 
tag. 
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Or you can remove the paragraph entirely ---
and leave the Title property in the metadata.

3/25/2021 Bouton Jones 66

 

 

Or you can remove the paragraph entirely and leave the property in the metadata. 
 
IMAGES:  Two screen captures showing the Tag panel in Adobe Acrobat.  In the first, the text 
“This is the title” is nested inside the P tag.  In the second, the P tag and the  
same text have been removed. 
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Checkpoint 08: OCR
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Index Failure Condition Section
08-001 OCR-generated text contains significant errors. UA1:7.1-10
08-002 OCR-generated text is not tagged UA1:7.1-10

 

 

Checkpoint 08: OCR Validation 
 
• OCR-generated text contains significant errors. 
• OCR-generated text is not tagged 
 
IMAGE:  Stylized text in a decorative font – “You Know You Wanna” 
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How reliable is OCR?

Original Image Post OCR Text

Bouton Jones3/25/2021 68

 

 

How Reliable is OCR? 
  
Table with two columns and four rows 
Column One:  Original Image 
Column Two:  Post OCR Text  
  
The screen captures in column one and column two appear identical. 
  
After performing OCR, usually the resulting renderable text looks exactly like the scanned image 
of text made with a decorative font or Word Art (e.g. "You Know You Wanna.")  It's visually 
indistinguishable to the original to me.  But now I can select the new text to copy or edit. 
  
Because electronic signatures were not an option for the last three examples, the documents 
were filled out online, printed, signed, and scanned. 
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How would a screen reader identify the text?

Bouton Jones

Adobe Read Out Loud

69

   now Adobe Read Out Loud is not an acceptable A11y checker or dedicated screen reader.)

 

 

How would a screen reader identify the following text? 
  
IMAGE:  Stylized text in a decorative font – “You Know You Wanna” 
  
How would Adobe’s Read Out Loud identify the Post OCR text above?   
  
As “You Know You Wanna?” 
  
Or something completely incomprehensible?  
  
AUDIO FILE:  Adobe Read Out Loud function saying “YDV H!fDW YOU WAHlfA?” 
 
Sorry.  I know Adobe Read Out Loud is not acceptable an A11y checker or dedicated screen 
reader. 
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How reliable is the OCR?

Post OCR Text Post OCR Text Copied and Pasted

210140-210145
Z10170-Z10177

Af>T JAR

YDV H!fDW YOU WAHlfA

Bouton Jones3/25/2021 70

 

 

Two Output Options: 
  
1. Editable Text and Image: 
  

• Converts the graphical text into vector text.  The vector text will replace the “text in 
image.” 

• You can now edit the document. 
  
2. Searchable Image 
  

• Places an invisible “layer” (not really a layer) on top of the text in graphic. 

• You can’t easily edit the document but it can be read by assistive technology (such as 
JAWS and NVDA.) 

  
Additional Resources on the Output Options: 

• Understanding OCR options in Adobe Acrobat: “Searchable Image”, “Searchable Image 
(Exact)”, and “Editable Text and Images” (Superuser) - 
https://superuser.com/questions/1276594/understanding-ocr-options-in-adobe-acrobat-
searchable-image-searchable-imag  



• Searchable Image vs. Searchable Image (Exact) - Quality of OCR (Adobe Community) - 
https://community.adobe.com/t5/acrobat/searchable-image-vs-searchable-image-exact-
quality-of-ocr/td-p/4734730?page=1  
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What does the “Recognize Text” (OCR) 
function do?

Does it convert the image of text in the image-only PDF into true text 
that can be edited like a Word document?

Or does Acrobat place an invisible layer of "renderable text" --- i.e. 
vector (computer generated) text --- on top of the image layer?
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What does the “Recognize Text” (OCR) function do? 
 
Does it convert the image of text in the image only PDF into true text that can be edited like a 
Word document? 
 
Or does Acrobat place an invisible layer of "renderable text" --- i.e. vector (computer generated) 
text --- on top of the image layer? 
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ORC Settings

Bouton Jones3/25/2021 72

If you click the Setting button on the Recognize Text menu …

 

 

Output Options for the Recognize Text (OCR) Function in Adobe Acrobat 2017 
 
If you click the Setting Button on the Recognize Text menu, you can choose among three options 
in the Recognize Text dialog box. 
 
• Searchable Image  
• Searchable Image (exact) 
• Editable Text and Image 
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Choose Output Options to Recognize Text Editable Text and Image

Converts the graphical text into 
vector text.  The vector text will 
replace the “text in image.”

This setting creates and embeds a 
custom font that looks like the 
original font in the image.  

You can now edit the text.

Searchable Image

Places an invisible “layer” (not 
really a layer) on top of the 
original image.

This setting does not alter the text 
in the image or embed a custom 
font.

You can’t easily edit the 
document, but it can be read by 
assistive technology (such as JAWS 
and NVDA.)
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Two Output Options: 
 
1. Editable Text and Image: 
 

Converts the graphical text into vector text.  The vector text will replace the “text in 
image.” 
 
It creates and embeds a custom font that looks like the original font in the image. 
 
You can now edit the text. 
 
The file size is larger 

 
2. Searchable Image 
 

Places an invisible “layer” (not really a layer) on top of the original image. 
 
You can’t easily edit the document but it can be read by assistive technology (such as 
JAWS and NVDA.) 
 

Additional Resources on the Output Options 
 



• Understanding OCR options in Adobe Acrobat: “Searchable Image”, “Searchable Image 
(Exact)”, and “Editable Text and Images” (Superuser) - 
https://superuser.com/questions/1276594/understanding-ocr-options-in-adobe-acrobat-
searchable-image-searchable-imag  

• Searchable Image vs. Searchable Image (Exact) - Quality of OCR (Adobe Community) - 
https://community.adobe.com/t5/acrobat/searchable-image-vs-searchable-image-exact-
quality-of-ocr/td-p/4734730?page=1  

 
 
 
 

  

https://superuser.com/questions/1276594/understanding-ocr-options-in-adobe-acrobat-searchable-image-searchable-imag
https://superuser.com/questions/1276594/understanding-ocr-options-in-adobe-acrobat-searchable-image-searchable-imag
https://community.adobe.com/t5/acrobat/searchable-image-vs-searchable-image-exact-quality-of-ocr/td-p/4734730?page=1
https://community.adobe.com/t5/acrobat/searchable-image-vs-searchable-image-exact-quality-of-ocr/td-p/4734730?page=1


Slide 74 

 

Searchable Image (Exact)
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Searchable Image (Exact) 
 
Deskew 
 
Deskew:  The process of straightening an image that has been scanned or photographed 
crookedly — that is an image that is slanting too far in one direction, or one that is misaligned. 
(Vangie Beal on webopedia) 
CITE: 
https://www.webopedia.com/TERM/I/image_de_skew.html#:~:text=By%20Vangie%20Beal%20
The%20process,Also%20called%20deskew.%5C  
 
IMAGES:  An original skewed page and a deskewed version side by side 
 
The Searchable Image setting will deskew the image before OCR. 
 
The Searchable Image (Exact) setting will NOT deskew the image before OCR. 
 
Often deskewing the image will lead to a smaller file size. 
 
But there may be a reason that you don’t want to alter the document.  (Ask a lawyer) 
 
RESEARCH:  Will the editable text setting deskew the image? 
  

https://www.webopedia.com/TERM/I/image_de_skew.html#:%7E:text=By%20Vangie%20Beal%20The%20process,Also%20called%20deskew.%5C
https://www.webopedia.com/TERM/I/image_de_skew.html#:%7E:text=By%20Vangie%20Beal%20The%20process,Also%20called%20deskew.%5C
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Checkpoint 09: Appropriate Tags
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Index Failure Condition Section
09-001 Tags are not in logical reading order. UA1:7.2-1
09-002 Structure elements are nested in a semantically inappropriate manner. (e.g., a table inside a 

heading). UA1:7.2-1

09-003 The structure type (after applying any role-mapping as necessary) of a structure element is 
not semantically appropriate. UA1:7.2-1

09-004 A table-related structure element is used in a way that does not conform to the syntax 
defined in ISO 32000-1, Table 337. UA1:7.2-1

09-005 A list-related structure element is used in a way that does not conform to Table 336 in ISO 
32000-1. UA1:7.2-1

09-006 A TOC-related structure element is used in a way that does not conform to Table 333 in ISO 
32000-1. UA1:7.2-1

09-007 A Ruby-related structure element is used in a way that does not conform to Table 338 in ISO 
32000-1. UA1:7.2-1

09-008 A Warichu-related structure element is used in a way that does not conform to Table 338 in 
ISO 32000-1. UA1:7.2-1

 

 

Checkpoint 09: Appropriate Tags 
 
09-001: Tags are not in logical reading order. 
09-002: Structure elements are nested in a semantically inappropriate manner. (e.g., a table 
inside a heading). 
09-003: The structure type (after applying any role-mapping as necessary) of a structure 
element is not semantically appropriate. 
09-004: A table-related structure element is used in a way that does not conform to the syntax 
defined in ISO 32000-1, Table 337. 
09-005: A list-related structure element is used in a way that does not conform to Table 336 in 
ISO 32000-1. 
09-006: A TOC-related structure element is used in a way that does not conform to Table 333 in 
ISO 32000-1. 
09-007: A Ruby-related structure element is used in a way that does not conform to Table 338 in 
ISO 32000-1. 
09-008: A Warichu-related structure element is used in a way that does not conform to Table 
338 in ISO 32000-1. 
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Checkpoint 14: Headings
Index Failure Condition Section

14-001 Headings are not tagged. UA1:7.4-1
14-002 Does use numbered headings, but the first heading tag is not H1. UA1:7.4.2-1

14-003 Numbered heading levels in descending sequence are skipped (Example: H3 follows 
directly after H1).

UA1:7.4-1

14-004 Numbered heading tags do not use Arabic numerals. UA1:7.4.3-1
14-005 Content representing a 7th level (or higher) heading does not use an “H7” (or higher) 

tag.
UA1:7.4.3-1

14-006 A node contains more than one H tag. UA1:7.4.4-1
14-007 Document uses both H and H# tags. UA1:7.4.4-3

NOTE: In weakly-structured documents, headings
always take the form “Hn” (e.g., H1, H2, Hn) without intervening whitespace or 
numerical separators.
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Checkpoint 14: Headings 
 

Index 
Failure Condition 
Section 
14-001 
Headings are not tagged. 
UA1:7.4-1 
14-002 
Does use numbered headings, but the first heading tag is not H1. 
UA1:7.4.2-1 
14-003 
Numbered heading levels in descending sequence are skipped (Example: H3 follows 
directly after H1). 
UA1:7.4-1 
14-004 
Numbered heading tags do not use Arabic numerals. 
UA1:7.4.3-1 
14-005 
Content representing a 7th level (or higher) heading does not use an “H7” (or higher) 
tag. 
UA1:7.4.3-1 
14-006 
A node contains more than one H tag. 



UA1:7.4.4-1 
14-007 
Document uses both H and H# tags. 

  
NOTE: In weakly-structured documents, headings 
always take the form “Hn” (e.g., H1, H2, Hn) without intervening whitespace or 
numerical separators. 
UA1:7.4.4-3 
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Why would you lose headings when 
exporting from Word to PDF?
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Why would you lose headings when exporting from Word to PDF? 
 
IMAGE: guillotine.  an apparatus designed for efficiently carrying out executions by beheading. 
The device consists of a tall, upright frame with a weighted and angled blade suspended at the 
top. The condemned person is secured with stocks at the bottom of the frame, positioning the 
neck directly below the blade. 
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Exporting Heading Levels from Word to PDF
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Exporting Heading Levels from Word to PDF 
 
First screen capture:  MS Word document showing 9 levels of headings 
Second screen capture:  PDF tag panel showing the tag panel for a PDF that was exported from 
the previously mentioned MS Word document 
 
The headings at level 7, 8, and 9 have exported as paragraphs in a PDF. 
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Heading Levels by MediumHeading levels above H6 are not standard structure types.

Table of Available Headers Levels by Medium

HTML 5 Word PDF

6 9 6

3/25/2021 Bouton Jones 79

 

 

Heading Levels by Medium 
 
Heading levels above H6 are not standard structure types 
 
Table of Available Headers Levels by Medium 
• HTML 5 has 6 heading level tags:  H1 through H6. 
• Microsoft Word has 9 heading levels. 
• PDF has 6 heading levels. 
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Checkpoint 17: Mathematical Expressions
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Index Failure Condition Section
17-001 Content is a mathematical expression but is not tagged with a Formula tag. UA1:7.7-1
17-002 Formula tag is missing an Alt attribute. UA1:7.7-1
17-003 Unicode mapping requirements are not met. UA1:7.7-2

 

 

Checkpoint 17: Mathematical Expressions 
 
17-001: Content is a mathematical expression but is not tagged with a Formula tag. 
17-002: Formula tag is missing an Alt attribute. 
17-003: Unicode mapping requirements are not met. 
 
IMAGES:  Two Screen captures showing 
• the Insert tab selected in the Word ribbon.  The Symbols section shows the Equation and 

Symbol functions 
• The Create New Building Block window 
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Checkpoint 18: Page Headers and Footers
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Index Failure Condition Section
18-001 Headers and footers are not marked as pagination artifacts. UA1:7.8-1
18-002 Header or footer artifacts are not classified as Header or Footer subtypes. UA1:7.8-1

These three semantic tags are listed under the Insert tab in Word.

 

 

Checkpoint 18: Page Headers and Footers 
 
18-001: Headers and footers are not marked as pagination artifacts. 
18-002: Header or footer artifacts are not classified as Header or Footer subtypes. 
 
IMAGE: These three semantic tags (Header, Footer, and Page Number) are listed under the 
Insert tab in Word. 
 
This is specific to Word.  It doesn’t apply to HTML. 
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Footer Experiment
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Will AT read the headers and footers? 
 
IMAGE: Screen capture of PDF showing the header and footer of a document 
 
If the PDF was exported from a properly tagged Word document, screen readers should not 
read the headers and footers.   But you should confirm this before and after properly exporting 
the source document to PDF. 
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So, what if the information in the header and 
footer is important?
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So, what if the information in the header and footer is important? 
 
If the information in the header and footer is important to the understanding of the content, 
you must repeat that information in the body of the document to ensure an equitable 
experience for the screen reader users. 
 
SCREEN CAPTURE: First page of a document repeating information from the header --- i.e. the 
document title and the published date --- in the body of the document (specifically on the first 
page.) 
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Checkpoint 22: Article Threads

22-001: Article threads do not reflect logical reading order.

In PDFs, articles are optional electronic threads that the PDF author 
defines within that PDF. Articles lead readers through the PDF 
content, jumping over pages or areas of the page that are not 
included in the article. It is the same way that you skim through a 
traditional newspaper or magazine, following one specific story and 
ignoring the rest. When you read an article, the page view zooms in 
or out so that the current part of the article fills the screen. 

CITE: https://helpx.adobe.com/acrobat/using/navigating-pdf-pages.html#article_threads
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Checkpoint 22:  Article Threads 
 
22-001: Article threads do not reflect logical reading order. 
 
"In PDFs, articles are optional electronic threads that the PDF author defines within that PDF. 
Articles lead readers through the PDF content, jumping over pages or areas of the page that are 
not included in the article. It is the same way that you skim through a traditional newspaper or 
magazine, following one specific story and ignoring the rest. When you read an article, the page 
view zooms in or out so that the current part of the article fills the screen."  (CITE: 
https://helpx.adobe.com/acrobat/using/navigating-pdf-pages.html#article_threads ) 
 
 

  

https://helpx.adobe.com/acrobat/using/navigating-pdf-pages.html#article_threads
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Defining Article Threads
"You create an article by defining a series of boxes around the 
content in the order in which you want the content read. The 
navigational path you define for an article is known as the article 
thread. You create a thread connecting the various boxes, unifying 
them into a continuous text flow.

....

"Most desktop publishing programs allow you to generate article 
threads automatically as you convert the files to Adobe PDF. If the 
file you’re viewing has articles, you can show the names of the 
articles on a tab and navigate easily through them." 

CITE: https://helpx.adobe.com/acrobat/using/pdf-articles.html
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Defining Article Threads 
 
"You create an article by defining a series of boxes around the content in the order in which you 
want the content read. The navigational path you define for an article is known as the article 
thread. You create a thread connecting the various boxes, unifying them into a continuous text 
flow. 
 
"Note: 
 
"Most desktop publishing programs allow you to generate article threads automatically as you 
convert the files to Adobe PDF. If the file you’re viewing has articles, you can show the names of 
the articles on a tab and navigate easily through them."  
 
CITE: https://helpx.adobe.com/acrobat/using/pdf-articles.html   
 
 

  

https://helpx.adobe.com/acrobat/using/pdf-articles.html
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Adobe InDesign Video: "The Articles panel"

URL: https://helpx.adobe.com/indesign/how-to/indesign-articles-panel.html
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Adobe InDesign Video: "The Articles panel" 
 
URL: https://helpx.adobe.com/indesign/how-to/indesign-articles-panel.html  
 
 

  

https://helpx.adobe.com/indesign/how-to/indesign-articles-panel.html
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Checkpoint 23: Digital Signatures
Electronic Signature

An electronic symbol attached to a contract or 
other record, used by a person with an intent to 
sign.

It can be a scanned image of a signature.  Or a text 
field.

Digital Signature
A cryptographically secure electronic signature 
that guarantees an electronic document is 
authentic.  They use a certificate-based digital ID 
issued by an accredited Certificate Authority (CA) 
or Trust Service Provider (TSP.)  

87IANAL | TINLA

Digital Signatures are a type of Electronic Signature.  All Digital Signatures are Electronic Signatures but not all 
Electronic Signatures are digital.

 

 

Checkpoint 23: Digital Signatures 
 
Types of eSignatures 
 
Electronic Signatures: An electronic symbol attached to a contract or other record, used by a 
person with an intent to sign. 
 
Digital Signature: A cryptographically secure electronic signature that guarantees an electronic 
document is authentic.  They use a certificate-based digital ID issued by an accredited 
Certificate Authority (CA) or Trust Service Provider (TSP.)  
 
Digital Signatures are a type of Electronic Signature.  All Digital Signatures are Electronic 
Signatures but not all Electronic Signatures are digital. 
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Testing your Digital Signature Fields

"No test specific to digital signatures is required, 
however other provisions apply (form fields).“

Digital signatures are form fields with a lot of functionality.

Test digital signatures “manually” with screen readers.
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Testing your Digital Signature Fields 
 
"No test specific to digital signatures is required, however other provisions apply (form fields).“ 
 
Digital signatures are form fields with a lot of functionality. 
 
Test digital signatures “manually” with screen readers. 
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Checkpoint 25: XFA

"XFA (also known as XFA forms) stands for XML Forms 
Architecture, a family of proprietary XML specifications 
… to enhance the processing of web forms. .... The XML 
Forms Architecture … has been deprecated in PDF 2.0.

"XFA forms are saved internally in PDF files or as XDP 
(XML Data Package) files which can be opened in Adobe's 
LiveCycle Designer software. An XDP can package a PDF 
file, along with XML form and template data. XDP provides 
a mechanism for packaging form components within a 
surrounding XML container."

CITE: https://en.wikipedia.org/wiki/XFA
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Checkpoint 25: XFA 
 
So What are XFA Forms? 
 
"XFA (also known as XFA forms) stands for XML Forms Architecture, a family of proprietary XML 
specifications that was suggested and developed by JetForm to enhance the processing of web 
forms. It can be also used in PDF files starting with the PDF 1.5 specification. The XFA 
specification is referenced as an external specification necessary for full application of the ISO 
32000-1 specification (PDF 1.7). The XML Forms Architecture was not standardized as an ISO 
standard,[3] and has been deprecated in PDF 2.0."   https://en.wikipedia.org/wiki/XFA  
 
 
 

  

https://en.wikipedia.org/wiki/XFA
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So, if you do not use Adobe LiveCycle …
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So, if you don’t use Adobe LiveCycle …  
 
XFA forms shouldn’t be a problem. 
 
IMAGE:  Man bent backward to dodge bullets fired at him. 
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Checkpoint 30: XObjects
Index Failure Condition Section

30-001 A reference XObject is present. UA1:7.20-1
30-002 Form XObject contains MCIDs and is referenced more than once. UA1:7.20-2
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SEE: https://www.prepressure.com/pdf/basics/form-xobjects

Form XObjects: a way of describing objects (text, images, vector elements,…) within a PDF file. It is meant for 
repetitive objects that only get stored once in a PDF but referenced multiple times. In a way, Form XObjects are 
similar to a mini-PDF embedded inside the main PDF document ... (CITE: 
https://www.prepressure.com/pdf/basics/form-xobjects )

Reference XObject: a form XObject which contains an optional Ref sub-dictionary. The sub-dictionary specifies 
a page in some target PDF file. (CITE: https://www.adobe.com/devnet-
docs/acrobatetk/tools/PrefRef/Windows/AVDisplay.html ) 

 

 

Checkpoint 30: XObjects  
 

30-001 A reference XObject is present. UA1:7.20-1 
30-002 Form XObject contains MCIDs and is referenced more than once.
 UA1:7.20-2 

 
Form XObjects: a way of describing objects (text, images, vector elements,…) within a PDF file. It 
is meant for repetitive objects that only get stored once in a PDF but referenced multiple times. 
In a way, Form XObjects are similar to a mini-PDF embedded inside the main PDF document ... 
(CITE: https://www.prepressure.com/pdf/basics/form-xobjects) 
 
Reference XObject: a form XObject which contains an optional Ref sub-dictionary. The sub-
dictionary specifies a page in some target PDF file. (CITE: https://www.adobe.com/devnet-
docs/acrobatetk/tools/PrefRef/Windows/AVDisplay.html )  
 
SEE: https://www.prepressure.com/pdf/basics/form-xobjects   
 
 

  

https://www.adobe.com/devnet-docs/acrobatetk/tools/PrefRef/Windows/AVDisplay.html
https://www.adobe.com/devnet-docs/acrobatetk/tools/PrefRef/Windows/AVDisplay.html
https://www.prepressure.com/pdf/basics/form-xobjects
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Checkpoint 31: Fonts
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Checkpoint 31: Fonts 
 
In HTML and CSS, you can choose alternative fonts 
 
--- Begin CSS --- 
 
HTML,  
BODY { 
    font-family: Calibri, "Trebuchet MS", Arial, Georgia, "Times New 
Roman", Helvetica, Serif; 
    font-size: 100%; 
    line-height: 1.125em;  
    margin-top: 0px;  
    margin-bottom: 0px; 
} 
 
--- End CSS --- 
 
If the Calibri is not installed on the user’s computer, the browser will use Trebuchet MS.  If 
Trebuchet MS is not installed, the browser will use Arial.  And so on and so forth. 
 
But in Word you can only select one font to use at a time.  
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If You are Missing an Embedded Font:
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When You Are Missing an Embedded Font 
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Adobe Acrobat’s Base 14 Fonts
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The standard fonts that can be referenced by name in a PDF document:

 

 

Adobe Acrobat’s Base 14 Fonts 
 
The Base 14 Fonts are defined in ISO 32000-1:2008(E) in Section 9.6.2.2. 
 
They are also referred to as the “Standard 14 Fonts,” the “Standard Type 1 Fonts”, and the 
“Standard Fonts.” 
 

• Monospaced Fonts: Courier, Courier Bold, Courier Oblique, Courier Bold-Oblique 
• Proportional Fonts (Sans Serif): Helvetica, Helvetica Bold, Helvetica Oblique, Helvetica 

Bold-Oblique 
• Proportional Fonts (Serif): Times Roman, Times Bold, Times Italic, Times Bold-Italic 
• Symbol 
• Zapf Dingbats 
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Checking If Fonts are Embedded in a PDF
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Checking If Fonts are Embedded in a PDF. 
 
To check whether the fonts are all embedded in your PDF file or not: 
• Open your PDF file 
• Click File> Document Properties 
• Click on the Fonts Tab to display the list of all fonts 
• All fonts are either Type 1 or TrueType fonts 
• All fonts should show as “Embedded Subset” 
 
CITE: https://kbpdfstudio.qoppa.com/how-to-embed-fonts-in-a-pdf-document/  
 
 

  

https://kbpdfstudio.qoppa.com/how-to-embed-fonts-in-a-pdf-document/
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Embedding Fonts in Word Docs
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1. In the Files tab select the More option.
2. Choose the Options option.
3. In the Words pane, select the Save option.
4. Select the “Embed fonts in the file” checkbox
5. Leave the “Embed only the characters used in the document (best for reducing 

file size)” checkbox.
6. Select the “Do not embed common systems fonts” checkbox.
7. Click the OK button to close this window.
8. You will need to use the “Save As PDF” or “Export to PDF”

The UI varies among releases of Microsoft Word.  Microsoft is likely to change it for 
future versions of Word

 

 

Embedding Fonts in Word Documents 
• In the Files tab select the More option. 
• Choose the Options option. 
• In the Words pane, select the Save option. 
• Select the “Embed fonts in the file” checkbox 
• Leave the “Embed only the characters used in the document (best for reducing file size)” 

checkbox. 
• Select the “Do not embed common systems fonts” checkbox. 
• Click the OK button to close this window. 
• You will need to use the “Save As PDF” or “Export to PDF” 
 
The UI varies among releases of Microsoft Word.  Microsoft is likely to change it for future 
versions of Word 
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Embedding Fonts in PDFs
1. Click File > Print
2. Click Adobe PDF
3. Click the Properties button to the right of the Printer Name text box
4. Select the tab Adobe PDF Settings
5. Edit the Default Settings
6. Click Fonts 
7. For Subset embedded fonts when percent of characters used is less than: Set the 

percentage to 100%
8. Select the Embed all Fonts option

A. For Embedding, select the folder with the fonts you want to embed from the drop-
down list

B. Make sure the fonts you need to embed are in the Always Embed box and not in 
the Never Embed box
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Embedding Fonts in PDFs 
 
Pro tip: a font can only be embedded if it contains a setting by the font vendor that permits it to 
be embedded. 
 
* Click File > Print 
* Click Adobe PDF 
* Click the Properties button to the right of the Printer Name text box 
* Select the tab Adobe PDF Settings 
* Edit the Default Settings 
* Click Fonts  
* For Subset embedded fonts when percent of characters used is less than: Set the percentage 
to 100% 
* Select the Embed all Fonts option 
    * For Embedding, select the folder with the fonts you want to embed from the drop-down list 
    * Make sure the fonts you need to embed are in the Always Embed box and not in the Never 
Embed box 
 
CITE: https://www.printivity.com/insights/2020/09/13/how-to-embed-fonts-in-pdfs/  
 
See also: VIDEO “How to Embed Fonts in a PDF using Acrobat pro-2017” (1:21) 
https://www.youtube.com/watch?v=Su50hSBGcW8  
  

https://www.printivity.com/insights/2020/09/13/how-to-embed-fonts-in-pdfs/
https://www.youtube.com/watch?v=Su50hSBGcW8
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How much does embedding fonts increase 
the file size?

NOTE: A common typography best practice is to limit the number of fonts you use 
on web pages and documents to 2 – 3.
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File Size
PDF with no embedded fonts 239 KB
PDF with one embedded font 248 KB
PDF with two embedded fonts 250 KB
PDF with three embedded fonts 250 KB
PDF with four embedded fonts 260 KB

NOTE: This was a quick and dirty check  --- not a rigorous scientific study.  Your results might vary.

 

 

How much does embedding fonts increase the file size? 
 
File    Size 
PDF with no embedded fonts  239 KB 
PDF with one embedded font  248 KB 
PDF with two embedded fonts 250 KB 
PDF with three embedded fonts 250 KB 
PDF with four embedded fonts 260 KB 
 
NOTES:   

• This was a quick and dirty check --- not a rigorous scientific study.  Your results might 
vary. 

• A best practice in web design is to limit the number of fonts you use on web sites.  It’s 
probably a good idea to limit the number of fonts you use in a document whether 
embedded or not. 
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I’m Almost Done Talking
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I’m Almost Done Talking 
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In My Next Installment …
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I didn’t have time --- or I didn’t learn enough --- to cover the following:

• Sexy Bling that Doesn't Export Well
• Bookmarks
• Spaces Existent
• Checkers
• Show the Document Title in the Title Bar
• Dublin Core
• More on Xobjects
• More on XFA

I’ll try to include them in a future presentation.  Or the Q&A, if someone asks.

 

 

In My Next Installment 
 
I didn’t have time --- or I didn’t learn enough --- to cover the following: 
 
• Sexy Bling that Doesn't Export Well 
• Bookmarks 
• Spaces Existent 
• Checkers 
• Show the Document Title in the Title Bar 
• Dublin Core 
• More on Xobjects 
• More on XFA 
 
I’ll try to include them in a future presentation.  Or in the Q&A, if someone asks. 
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Last Point: the PDF Association’s 
Recommendation

CITE: https://www.pdfa.org/resource/pdfua-in-a-nutshell/
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Last Point: The PDF Association’s Recommendation 
 
“In principle, universally-accessible PDF documents can either be generated directly during 
document creation, using a suitable program, or indirectly generated by adapting an existing 
PDF document. The indirect approach tends to require a great deal of work, as all tags and 
numerous other settings will need to be provided manually.” 
 
“This work can also become void as soon as a new version of the PDF document replaces the 
old one, if any changes to the document’s content need to be made. The adaptation process 
must then be started again from scratch.” 
 
“The direct approach is almost always the better option; post-creation PDF edits should be 
avoided or at least kept to a minimum. .” 
 
CITE:  https://www.pdfa.org/resource/pdfua-in-a-nutshell/   
 
 
 

  

https://www.pdfa.org/resource/pdfua-in-a-nutshell/
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Additional Resources

• The PDF Association: https://www.pdfa.org/

• The PDF Accessibility group on Facebook: 
https://www.facebook.com/groups/PDFAccessibility/

• Tagged PDF: https://taggedpdf.com/

• Austin Accessibility and Inclusive Design (Meetup Group): 
https://www.meetup.com/a11yATX

• AccessU (A11y conference in May): https://knowbility.org/programs/accessu/2021/
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• The PDF Association: https://www.pdfa.org/  
 

• The PDF Accessibility group on Facebook: 
https://www.facebook.com/groups/PDFAccessibility/  

 
• Tagged PDF: https://taggedpdf.com/   

 
• Austin Accessibility and Inclusive Design (Meetup Group): 

https://www.meetup.com/a11yATX   
 

• AccessU (A11y conference in May): https://knowbility.org/programs/accessu/2021/   
 
 

  

https://www.pdfa.org/
https://www.facebook.com/groups/PDFAccessibility/
https://taggedpdf.com/
https://www.meetup.com/a11yATX
https://knowbility.org/programs/accessu/2021/
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Closing Summary
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Closing Summary 
 
Follow both sets of guidelines --- WCAG and PDF/UA --- and use the Matterhorn Protocol as a 
checklist for the PDF/UA. 
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Any Questions?
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Any Questions? 
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Thank You For Your Time!
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Thank You.  This concludes this session. 


